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Introduction Read this Instruction Manual 
thoroughly before using the 
product.
Thank you for purchasing the LabSolutions GPC software for Shimadzu High 
Performance Liquid Chromatography Workstation (hereafter referred to as "the 
software" or "LabSolutions GPC").

LabSolutions GPC works as an extension of LabSolutions, and enables you to conduct 
GPC analysis on data acquired by LabSolutions under various conditions.

LabSolutions GPC operates on Window 7. Other PC hardware requirements conform 
to those for LabSolutions.

This manual explains the basic operations of LabSolutions GPC. Read this manual 
thoroughly before using the product and operate the product in accordance with the 
instructions in this manual. 

Keep it in a safe place so that it can be referred to whenever you have questions 
regarding the operation of this product.

This manual assumes that readers are knowledgeable of basic operation of the LC 
workstation software, LabSolutions. Refer to 'Operation Manual' of LabSolutions for 
points that are not explained in this manual.

This manual assumes that the reader is knowledgeable of basic operations of 
Windows. For the operation of Windows, refer to the instruction manual that comes 
with that product.

This manual includes contents that are common across the LabSolutions series. Note 
that the screen captures inserted in the text may be those of the similar product if there 
are no significant discrepancies in the explanation.  

Important • If the user or usage location changes, ensure that this Instruction Manual is 
always kept together with the product.

• If this manual is lost or damaged, immediately contact your Shimadzu 
representative to request a replacement.

• To ensure safe operation, contact your Shimadzu representative if product 
installation, adjustment, or reinstallation (after the product is moved) is required.

© 2014-2015 Shimadzu Corporation. All rights reserved.
Original version is approved in English.
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Notice • Information in this manual is subject to change without notice and does not 
represent a commitment on the part of the vendor.

• Any errors or omissions which may have occurred in this manual despite the 
utmost care taken in its production will be corrected as soon as possible, 
although not necessarily immediately after detection.

• All rights are reserved, including those to reproduce this manual or parts thereof 
in any form without permission in writing from Shimadzu Corporation.  

• Microsoft and Windows are registered trademarks of Microsoft Corporation in the 
United States and/or other countries.
Adobe, Adobe logo and Adobe Reader are trademarks or registered trademarks 
of Adobe Systems Incorporated in the United States and/or other countries.
Other company names and product names mentioned in this manual are 
trademarks or registered trademarks of their respective companies. The TM and 
® symbols are omitted in this manual.

• Microsoft® Windows® 7 Operating System is referred to as "Windows 7".

• Replacement parts for this product will be available for a period of seven (7) 
years after the product is discontinued. Thereafter, such parts may cease to be 
available. Note, however, that the availability of parts not manufactured by 
Shimadzu shall be determined by the relevant manufacturers.
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Instruction Manuals
List of Instruction Manuals

NOTE

Also, refer to the manuals for LabSolutions if necessary. For details, refer to the manuals for LabSolutions.

Reference
"8  Appendix"

Indications Used in Instruction Manuals
Cautions and Notes are indicated using the following conventions, and the following symbols are used in this 

manual:

Name Content

Notice Before Using Explains the information necessary to use the LabSolutions GPC, such as how to update, how 
to convert the data and caution about the specification of GPC.

Instruction Manual (This 
document)

Explains data acquisition and analysis procedures of LabSolutions GPC for various purposes.

Quick Manual Explains basic analysis excerpted from the Instruction Manual.

Help Clicking the on-screen [Help] button or pressing the [F1] key displays a description of on-screen 
parameters, answers to specific questions or solutions to various problems.
Also, clicking the [Help] button on the error message window displays the details of the error or 
solutions to the error. Be sure to refer to Help before contacting us.
For information on how to use it, refer to "8.1.1 Using Help" on page 111 in this manual.

Indication Meaning

NOTE Emphasizes additional information that is provided to ensure the proper use of this product.

Reference Indicates the location of related reference information.

'  ' The names of the instruction manuals.

"  " The names of programs and products.

[ ] Indicates the names of buttons, menu options, setting options, windows/sub-windows, and icons 
that are displayed in a window.
Example: Click [OK].

[ ] - [ ] When several operations are performed one after another, hyphens are used to show the 
sequence.
Example: Select [File] - [Print].

Click the [File] menu and select [Print].
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Warranty Shimadzu provides the following warranty for this product.

1. Period: Please contact your Shimadzu representative for information about the 
period of this warranty.  

2. Description: If a product/part failure occurs for reasons attributable to Shimadzu during 
the warranty period, Shimadzu will repair or replace the product/part free of 
charge (including USB dongles). However, in the case of products which 
are usually available on the market only for a short time, such as personal 
computers and their peripherals/parts, Shimadzu may not be able to 
provide identical replacement products.

3. Limitation of Liability: (1) In no event will Shimadzu be liable for any lost revenue, profit or data, or for 
special, indirect, consequential, incidental or punitive damages, however 
caused regardless of the theory of liability, arising out of or related to the 
use of or inability to use the product, even if Shimadzu has been advised of 
the possibility of such damage.  

(2) In no event will Shimadzu's liability to you, whether in contract, tort 
(including negligence), or otherwise, exceed the amount you paid for the 
product.

4. Exceptions: Failures caused by the following are excluded from the warranty, even if 
they occur during the warranty period.

1) Improper product handling

2) Repairs or modifications performed by parties other than Shimadzu or 
Shimadzu designated companies

3) Product use in combination with hardware or software other than that 
designated by Shimadzu

4) Computer viruses leading to device failures and damage to data and 
software, including the product's basic software

5) Power failures, including power outages and sudden voltage drops, leading 
to device failures and damage to data and software, including the product's 
basic software

6) Turning OFF the product without following the proper shutdown procedure 
leading to device failures and damage to data and software, including the 
product's basic software

7) Reasons unrelated to the product itself

8) Product use in harsh environments, such as those subject to high 
temperatures or humidity levels, corrosive gases, or strong vibrations

9) Fires, earthquakes, or any other act of nature, contamination by radioactive 
or hazardous substances, or any other force majeure event, including wars, 
riots, and crimes

10)Product movement or transportation after installation

11) Consumable items
Note: Recording media such as floppy disks and CD/DVD-ROMs are 
considered consumable items.

* If there is a document such as a warranty provided with the product, or there is a separate contract agreed upon that 
includes warranty conditions, the provisions of those documents shall apply. 

* Warranty periods for products with special specifications and systems are provided separately.

* The license cannot be reissued if you lose the USB dongle provided with the product. 
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1

Overview of 
LabSolutions GPC

LabSolutions GPC is software that runs on LabSolutions platform. Data acquisition and analysis can 
be performed using operations similar to LabSolutions.

This document describes only those items different from LabSolutions. See 'Operation Manual' of 
LabSolutions for descriptions on "data acquisition", "peak integration" and "batch processing".

1.1 What is GPC?
GPC is short for Gel Permeation Chromatography, and is also called Size Exclusion. 
Chromatography. This is a type of separation method used in liquid chromatographs, in which sample 
compounds are physically separated by the size of molecules, regardless of any chemical interaction 
between sample components and the stationary phase.

1.2 Functions of LabSolutions GPC
LabSolutions GPC is optional software for LabSolutions that calculates molecular weight distribution 
and various average molecular weight values from the data acquired by a gel permeation 
chromatograph. It enables you to generate parameters and graphs for evaluating characteristics of a 
polymer sample using the similar operations with LabSolutions. Furthermore, statistical calculation of 
those values and their comparison by overlaying graphs are possible.

Configuration of the LabSolutions GPC Software
LabSolutions GPC consists mainly of the following three applications:

• GPC Data Analysis
Calculates the molecular weight distribution and average molecular weight values of an unknown sample 
from a calibration curve generated by "GPC Calibration Curve".

• GPC Calibration Curve
Generates a calibration curve* that is used to calculate the molecular weight and molecular weight 
distribution of an unknown sample.
* A graph showing the relationship between the logarithm of the molecular weight of the samples and the 

elution time (eluent volume)
• GPC Data Comparison

Enables you to compare chromatograms and differential and integral molecular weight curves of multiple 
unknown samples by overlaying the graphs.

• Batch Postrun
GPC data analysis can be performed for data from multiple samples.

• Report Creation
In addition to the usual report items, report items for outputting GPC analysis results, including molecular 
weight distribution calculation results, are added.

File Compatibility
• GPC method files of CLASS-LC10/CLASS-VP can be imported and used.
• LCsolution GPC data files and method files can be read as they are. However, files created with 

LabSolutions GPC cannot be read by LCsolution GPC. 
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1.3 Description of Terms
Following are descriptions on terms used in LabSolutions GPC:

Term Description
Mn A number average molecular weight, which is calculated based on the total 

number of molecules
Mw A weight average molecular weight, which is calculated based on the total 

weight of molecules
Mz A Z average molecular weight
Mz1 A Z+1 average molecular weight
Mv A viscosity average molecular weight
Q factor A molecular weight per unit chain length of a polymer
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2

Starting the Analysis

This chapter describes the basic operation of LabSolutions GPC. For better understanding, it is 
recommended that you actually operate LabSolutions GPC and work through the analysis procedure 
of this chapter.

To specify the instrument control parameters for data acquisition and the peak integration 
parameters, refer to "LabSolutions Operation manual". This manual primarily describes the 
procedures particularly required for operating LabSolutions GPC.

2.1 Before Reading This Chapter

2.1.1 The Data Structure of LabSolutions GPC
This section gives a brief explanation about the data structure of LabSolutions GPC.
Adding to method parameters for LC Analysis and LC Postrun, the GPC data file also stores various data, 
such as GPC calibration curve information and GPC calculation parameters. 
This ensures the traceability of data since the analysis conditions and parameters can be referenced from 
the data file itself. In addition, you can reanalyze the data using only the data file.

NOTE
The method information stored in the data file is the duplicate of the method file used during the acquisition 
and analysis of data. Therefore, when modifying the method parameter in the data file, only the "method in 
data" is modified and no changes are made to the original method file. But the original method file can be 
updated accordingly with the modified method in the data file by using "Apply to the Method File" (save as a 
method file) function.

2.1.2 LabSolutions GPC Operation Flow
In this chapter, the operation flow of LabSolutions GPC is explained as shown in the following chart. 
In LabSolutions GPC, adding to the parameters for LabSolutions, you set parameters for calibration curve, 
molecular weight calculation, etc. in a method file. You can create calibration curves in the [GPC Postrun] 
program, and once you have set all these parameters, you can perform GPC calculation, such as 
molecular weight calculation, while performing data acquisition by using the method file. 

Explanation on how to view the following chart:
Operation

Application
Target files
(Their file name extensions)
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File Names

File Names extension contents
Method file .lcm Analysis conditions, postrun analysis conditions, calibration 

curve conditions
Report format file .lsr Report format
Batch file .lcb Batch table, batch settings
Data file .lcd Chromatogram, Peak table, Report format (Report format in 

data), Method (copy), Batch table (copy)

LabSolutions
[Realtime Analysis] - [Data Acquisition] 
LabSolutions Method file (.lcm)

LabSolutions [Realtime Analysis] - [Data 
Acquisition] or [Batch Processing]
LabSolutions Data file (.lcd), Batch file (.lcb)

[GPC Postrun] - [GPC Data Analysis]
Modifying the method in the data file (.lcd)
Can modify the method file (.lcm) 
accordingly

[GPC Postrun] - [Report Generator]
Creates a report format file (.lsr) for GPC 
Postrun data.

LabSolutions [Realtime Analysis] - [Data 
Acquisition] or [Batch Processing]
Data file (.lcd), and Batch file (.lcb)

[GPC Postrun] - [GPC Data Analysis] or 
[Batch Processing]
Data file (.lcd)

[GPC Postrun] - [GPC Data Analysis], and 
[GPC Data Comparison] 
Data file (.lcd)

Setting the analysis conditions

  Analyzing standard sample

Setting peak integration parameters

  Reanalyzing the results

  Viewing results

  Analyzing unknown sample

  Creating reports

[GPC Postrun] - [GPC Calibration Curve]
Creates a calibration curve in a method file 
(.lcm) using data files (.lcd) of standard 
samples.

  Creating calibration curves
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2.2  Starting LabSolutions Analysis

NOTE
• In a batch table, the method file (.lcm) and the report format file (.lsr) are specified for each particular data 

file (.lcd). When the batch analysis is completed, it creates a data file (.lcd) containing the same 
information stored in the batch table (.lcb) and .lcm and .lsr (when a report is output) set for each line of 
the batch table.

• When you open a method file (.lcm) in the [GPC Calibration Curve] window, the data files (.lcd) for all 
levels in the calibration curve are loaded simultaneously. If the method file (.lcm) is edited here, the data 
can be recalculated using the new analysis conditions for each data file (.lcd) that has been imported. You 
can also optimize the quantitative method and the calibration curve type beside adding or deleting 
calibration level data.

2.2 Starting LabSolutions Analysis

1 Display the [LabSolutions Main] window.

2 Click  (Instruments).

3 Double-click on the instrument to use for analysis.

The [Realtime Analysis] program will start.
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2.3 Preparing for Analysis
Referring to "LabSolutions Operation Manual", complete the system configuration and the preparation of 
analytical instruments, and specify the instrument parameters as required. This section primarily explains 
how to set parameters necessary for LabSolutions GPC analysis, such as the integration parameters, etc. 
You can also set the parameters when creating calibration curves in the [GPC Postrun] program after 
completing standard sample analysis.

2.3.1 Setting Data Analysis Parameters

1 Click [Data Processing Parameters] from the [Method] menu in the [Realtime Analysis] 
program.

The [Data Processing Parameters] screen appears.

LabSolutions GPC performs the molecular weight calculation, etc., using "slice data". The "slice data" 
refers to the height values obtained by separating chromatograms by a certain time interval. Therefore, in 
addition to configuring the usual integration parameters in LabSolutions, the following settings must also 
be configured in the [Data Processing Parameters] screen.
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2.3  Preparing for Analysis

Setting the Maximum Number of Slices
The maximum number of slices corresponds to the maximum number of "slice data" that can be stored in a 
data file. You can set this value up to [50000].

1 Click [Advanced] in the [Integration] tab.

2 Enter the number of slices in [Max.Slices].
Set the maximum value: [50000].

NOTE
Each slice interval is 1/10 of the time (sec) specified as [Width] in the integration parameters. The 
interval information is stored for each area detected as a peak. If a width of a detected peak is quite 
long and the number of slices exceeds [50000], an error message appears. In this case, set the 
larger value for [Width].

3 Click [OK].
This confirms the setting of the maximum number of slices.
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Setting T.DBL
T.DBL is a parameter that is used to automatically integrate peaks which broaden with time by increasing 
[Width] and decreasing [Slope] according to the time specified.

1 Enter [1000] in [T.DBL].

2 Click [OK].

NOTE
If [T.DBL] is enabled in molecular weight distribution calculation, [Width] increases with time as a 
function of the parameter. It follows the increase of intervals of slice data, and consequently the 
molecular weight calculation may not be performed properly. To avoid this, you set [T.DBL] to [1000] 
to disable this parameter.
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2.3  Preparing for Analysis

 Setting GPC Calculation Parameters

1 Click the [GPC Calculation] tab and configure the settings.

2 Click [OK].

Reference

"4.4.3 Setting Data Analysis Parameters"

NOTE

• Configure the settings in the [GPC Data Analysis] window or in the [GPC Calibration Curve] 
window.

• If you have set these parameters in the [GPC Data Analysis] window, you need to apply the 
"method inside data file" to the original method file by using "Apply to Method" function. 
Also, you can create calibration curves in the [GPC Calibration Curve] window.

No. Description

Enter the element name. Up to 64 characters can be entered. The initial value is blank.

Enter the Q factor. A positive real number can be entered. The initial value is [1].

Enter the alpha value used for Mark Houwink conversion, etc. The initial value is [0].
(Alpha to be displayed for standard polymer are those specified in the [GPC Calibration Curve] tab.)

Enter the K value used for Mark Houwink conversion, etc. The initial value is [1].
(K to be displayed for standard polymer are those specified in the [GPC Calibration Curve] tab.)

Select whether you use the pump flow or a manually input value for the flow calculation. If you use a 
manually input value, set the flow quantity per minute.

Select the molecular weight or the degree of polymerization for the display unit of the Y axis. [Molecular 
weight] is selected initially. By selecting [Degree of Polymerization], you can enter [Molecular Weight] 
per degree of polymerization.

Select a channel of the detector.

Specify whether to perform the GPC calculation for each channel.

Select a method of the time correction. [None] is selected initially.

Specify whether to perform the sensitivity compensation of the RI detector. When performing 
compensation, click [Settings] and set the sensitivity compensation of the RI detector.

Click this to display the [RT/MW range setting] screen.
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2.3.2 Saving Method Files

1 Click [Save Method File As] from the [File] menu.

2 Input the file name and click [Save].

NOTE
You can specify the default location for saving files by selecting the project folder in [File] -[Select 
Project (Folder)].

2.4 Analyzing Standard Samples
When creating a calibration curve based on the analysis results of standard sample data, you need to 
complete the data acquisition prior to the calibration curve creation. Referring to "LabSolutions Operation 
Manual", analyze the standard sample through the single or batch analysis to acquire the sample data.

2.5 Creating Calibration Curve
In LabSolutions GPC, you create calibration curves in the [GPC Calibration Curve] window of the [GPC 
Postrun] program. Prior to that, you need to set [Integration Parameters] and [GPC Calculation 
Parameters].
This section describes how to create the calibration curve using the data already acquired.
The following is the brief explanation for the procedures:
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2.5  Creating Calibration Curve

2.5.1 Displaying the [GPC Calibration Curve] Window

1 Display the [LabSolutions Main] window.

2 Click  (Postrun).

3 Double-click  (GPC Postrun).

The [GPC Postrun] program will start.

NOTE

• Click  (GPC Postrun) for GPC data analysis, including molecular weight distribution 

calculation, as you click  (Postrun) for the regular data analysis.

• If  (GPC Postrun) is not displayed on the menu, the license for LabSolutions GPC is not 

recognized in your system. Use the USB dongle that stores the license.
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4 Click  (GPC Calibration Curve) from the [Main] assistant bar in the [GPC 

Postrun] program.

The [GPC Calibration Curve] window appears.

NOTE
When the [GPC Calibration Curve] window is displayed, no data has been loaded yet.
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2.5  Creating Calibration Curve

2.5.2 Opening Method File
Open the method file used for analyzing the standard sample.

1 Click [Open Method File] from the [File] menu.

2 Select the method file and click [Open].

NOTE
You can select either LabSolutions method files or those from older software versions.

2.5.3 Displaying Data Files

1 Click [Data File List] from the [Data] menu.
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2 Click [Add].

3 Select the standard sample data you wish to use for creating calibration curve, and click 
[Open].

4 Verify that the data file of the standard sample is displayed in the data file list, and click 
[OK].

NOTE
To select multiple sample data, repeat this procedure as necessary.
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2.5  Creating Calibration Curve

2.5.4 Picking up Retention Time

1 Click [Edit] in the [Calibration Table View] screen.

2 Click [Pick up] in the [Calibration Table View] screen.

3 Click [All peaks] or [Select peaks].
Select [All peaks] when importing data of the whole retention time, and select [Select peaks] when 
importing data for a certain time range. When [Select peaks] is selected, use the mouse to specify the 
range on the chromatogram.
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2  Starting the Analysis

4 Click [New] or [Add].
Select [New] when importing peak data after deleting an existing calibration curve. Select [Add] when 
adding peak data to existing calibration points.

5 Set the parameters not yet defined in the calibration curve table, such as molecular 
weight values.

NOTE
• You can import parameter values from the [Table Edit] menu or by right-clicking and opening the 

[Import Calibration Table] screen from the menu. When importing a method file, pick up the 
[retention time] after importing. To do so, click [Retention Time Refresh] in the [GPC Method Edit] 
screen.

• In the edit mode of Calibration Table View, you can delete unnecessary calibration points by 
selecting the row of the calibration point and selecting [Delete Row] from the right-click menu.

• Peak data is sorted by the retention time when switching the edit mode to the view mode.
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2.5  Creating Calibration Curve

2.5.5 Setting Calibration Curve Parameters

1 Select [Data Processing Parameters] from the [Method] menu.

2 Select the [Curve] type in the [GPC Calibration Curve] tab, and click [OK].

NOTE

If the number of calibration points is not enough, the calculation for high order calibration curve may 
not be performed.
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2.5.6 Saving Calibration Curves

1 Verify the calibration curve created in the [Calibration Curve View] screen.

NOTE
To modify the calibration curve, configure the settings again in the [Data Processing Parameters] - 
[GPC Calibration Curve] tab.

2 Click [Save Method File] from the [File] menu.

The calibration curve is saved in the method file.
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2.6  Creating Report Format

2.6 Creating Report Format
The procedures on creating a report format or summary report format of GPC analysis data are similar to 
those for LabSolutions. Refer to "LabSolutions Operation Manual".
In LabSolutions GPC, the report items for outputting the results of GPC analysis, such as molecular weight 
distributions, are newly added to the existing items. For more details, refer to "6  Report Function".

2.7 Analyzing Unknown Samples
This section describes the procedures for analyzing unknown samples through batch processing, using a 
method file where the integration parameters and calibration curve are set in procedures "2.3 Preparing for 
Analysis" and "2.5 Creating Calibration Curve". 

2.7.1 Performing Batch Analysis
Set the schedule for continuous analysis.

1 Click  (Realtime Batch) from the [Main] assistant bar in the [Realtime Analysis] 

program.

2 Select [New Batch File] from the [File] menu.
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2  Starting the Analysis

3 Enter the batch analysis schedule in the batch table.
The main items to be entered into the batch table are as follows:

NOTE
If an item is not displayed in the table, right-click on [Batch Table] and click [Table Style] from the 
menu to set [Display Items].

4 Click  (Save) in the toolbar, and save under a new name.
The content of the batch table is saved.

5 Click  (Start) in the toolbar to start batch analysis.

NOTE
The correction factor is not updated when the correction peaks of the control sample cannot be 
identified. The control sample is corrected using the correction factor before the analysis.

Parameter Description
Vial# Enter the vial number of the sample injected by the autosampler. If no sample is being 

injected, enter "-1".
Tray Name Enter the tray number of the sample injected by the autosampler. No entry is necessary 

when using an autosampler without multiple tray settings.
Inj. Volume Enter the injection volume (unit: μL).
Sample Type Select the sample type. 

In LabSolutions GPC, [GPC Control Sample] is added in the list in order to specify the 
correction according to the control sample.
When you analyze an unknown sample first, enable [Initialize GPC Control] to initialize the 
correction factor.

Method File Specify the method file to be used for the analysis.
Data File Name the data that is to be saved as the analysis results.

When the file name is entered without a path, the data is created in the currently browsed 
project folder (as previously specified).

No. Description
The GPC Control Sample is used for correction of retention time.
Initializes the parameter for the time correction by GPC Control Sample.
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2.8  Performing GPC Calculation

2.8 Performing GPC Calculation
This section describes how to view the results of analyzing molecular weight distribution of unknown 
samples, etc., and how to set the GPC calculation parameters used for calculating molecular weight 
distributions. By applying the GPC parameters optimized here to a method file and performing [Batch 
Processing] in the [GPC Postrun] program, you can reanalyze multiple unknown sample data in the same 
conditions.

2.8.1 Displaying the GPC Data Analysis Results

1 Click  (GPC Data Analysis) from the [Main] assistant bar in the [GPC Postrun] 
program.

2 Click [Open Data File] from the [File] menu.

3 Select the data file, and click [Open].
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2  Starting the Analysis

The data file of unknown sample is loaded, and the chromatogram view displays the chromatogram, the 
calibration curve, and the molecular weight distribution curve.
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2.8  Performing GPC Calculation

2.8.2 Setting the Parameters for Molecular Weight Calculation

1 Select [Data Processing Parameters] from the [Method] menu.

2 Click the [GPC Calculation] tab to verify the parameters.
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2  Starting the Analysis

 Setting RT/MW Range

1 Click [RT/MW Range Settings] in the [GPC Calculation] tab.

2 Select [Time] or [M.W.], and input the RT/MW range.

3 Click [OK].
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2.8  Performing GPC Calculation

2.8.3 Performing GPC Calculation

1 Click [OK] in the [Data Processing Parameters] screen.
The data is analyzed, and the chromatogram view displays the molecular weight distribution curve and 
the integrated molecular weight distribution curve. 

2 View the analysis results.

NOTE
When reanalyzing the data, click the [GPC Calculation] tab from the [Data Processing Parameters] 
screen, and modify the calculation parameters.

2.8.4 Viewing Calculation Results
The calculation results for the slice data, peak table, average molecular weight table, and RT/MW range 
table can be checked.

1 Click the appropriate item from the [View] menu.

2 Click the appropriate tab in the [Result Display] screen to check the contents.
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2  Starting the Analysis

2.9 Comparing GPC Data
You can overlay multiple results of GPC molecular weight calculation in one view, and also perform the 
statistical calculation. 

2.9.1 Displaying the [GPC Data Comparison] Window

1 Click  (GPC Data Comparison) from the [Main] assistant bar in the [GPC Postrun] 

program.

NOTE
See "5  GPC Data Comparison" for details on the [GPC Data Comparison] window.
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2.9  Comparing GPC Data

2 Drag and drop data files to compare from Data Explorer to the [GPC Data Comparison] 
window view.

The chromatogams and molecular weight distribution curves appear.

NOTE
When different channels are used for GPC calculation in the drag-and-dropped files, the data file list 
appears so that you can select a detector channel.

Shifting Chromatograms
As you shift chromatograms, the molecular weight distribution curve and the integrated molecular weight 
distribution curve shift accordingly.

1 Click [Shift Chromatogram Data] from the [Process] menu.
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2  Starting the Analysis

2 Configure the settings.

3 Click [OK].

NOTE

Chromatograms can be shifted as follows: Select the target data in the data list view, click  (Move 
Left/Right) in the chromatogram view, then drag the chromatogram.

Statistical Calculation Results

1 Select [Statistical Calculation Results] from the [View] menu.

The [Statistical Calculation Result] screen appears.
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3

Generating Calibration 
Curves

Calibration curves are registered in a method file by detector or channel. The molecular weight is 
calculated besed on the eluent volume of analysis sample by a formula using the eluent volume and 
the molecular weight of the standard sample.

To create calibration curves, check the [GPC Calculation] box on the [GPC Calculation] tab of the 
[Data Processing Parameters] window.

3.1 Displaying the [GPC Calibration Curve] Window

1 Click  (GPC Calibration Curve) in the [Main] assistant bar of the [GPC Postrun] 

program.

The [GPC Calibration Curve] window appears.
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3.2 Using and Viewing the [GPC Calibration Curve] Window
The [GPC Calibration Curve] window has [Calibration Curve View], [Chromatogram View], and [Calibration 
Table View]. (The areas sectioned by splitters (frames) are called "Views". You can customize the layout 
and adjust the display area by dragging the splitters.)

[Calibration Curve View]

[Chromatogram View]

[Calibration Table View]



 LabSolutions GPC Instruction Manual   31

3.3  Calibration Table View

3

3.3 Calibration Table View
In this view, you can set information about calibration points for creating a calibration curve.

3.3.1 Calibration Table
A calibration table displays information of calibration points in the table format. It can be entered and 
modified only in the edit mode. The calibration point information includes the following items.

NOTE
If an item is not displayed in the table, right-click on [Calibration Table], click [Table Style] from the menu, and 
set [Display Items].

No. Description
Click this to switch the calibration table into the view mode.
Click this to switch the calibration table into the edit mode.
Enter comments for the calibration curve. You can enter up to 64 characters.
Displays the setting of Mark Houwink conversion that is set in the data analysis parameters.
Displays the setting of time conversion that is set in the data analysis parameters.
Click this to import the peak data of the chromatogram displayed in the Chromatogram View into the calibration table.
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NOTE
When generating a calibration curve with chain lengths, enter chain lengths for molecular weights, and set 
the Q factor correctly. When generating a calibration curve with molecular weights, set the Q factor to 1 (the 
default value).

Reference
"4.4.3 Setting Data Analysis Parameters", "  The Use of the Q Factor"

Name Description
# Displays the numbers (1 - 64).
Time (min.) Enter the time of a calibration point (peak position). The value larger than the filtration 

limit time should be entered. Enter the time after conversion when the time conversion 
is enabled.

Molecular Weight Enter the molecular weight of a calibration point (peak position). Enter the molecular 
weight after the conversion when the Mark Houwink conversion is enabled.

Active Check this to make the calibration point active. If unchecked, the calibration point is 
not used to calculate a calibration curve, and it is not displayed on the calibration curve 
graph in the calibration curve view.

Virtual Check this to make the calibration point virtual. Virtual points are used as a 
supplement when a calibration curve cannot be properly calculated using only the 
peak data.

Weight Select the weight from among [1000], [100], [10], [1], [1/10], [1/100], and [1/1000].
This can be entered when the [Weight] box is checked in the [Calibration Curve] tab of 
the [Data Processing Parameters] screen.

Error (%) Displays errors between the calculated value of the calibration curve and the 
molecular weight. An error is calculated by the following formula. 
Error = (Molecular Weight - Calculated Value of Calibration Curve) * 100 / Molecular 
Weight

The following items display information about the peaks when the peak data is picked up from a 
chromatogram. Values cannot be entered manually to these items in the table. [-] is displayed unless peak 
data is picked up.

Peak# Displays the peak numbers in a data file from which the time information is picked up.
Acquired by Displays who acquired the data file from which the time information is picked up.
Date Acquired Displays the data acquired date of the data file from which the time information is 

picked up.
Time Acquired Displays the data acquired time of the data file from which the time information is 

picked up.
Sample Name Displays [Sample Name] of the data file from which the time information is picked up.
Sample ID Displays [Sample ID] of the data file from which the time information is picked up.
Tray Name Displays [Tray Name]  of the data file from which the time information is picked up.
Vial Number Displays [Vial Number] of the data file from which the time information is picked up.
Data File Displays [Data File Name] of the data file from which the time information is picked up.
Original Data File
(Full Path)

Displays [Original Data File] of the data file from which the time information is picked 
up.

Original Method File 
(Full Path)

Displays [Original Method File] of the data file from which the time information is picked 
up.

Background Data File Displays [Background Data File] of the data file from which the time information is 
picked up.

Report Format File Displays [Report Format File] of the data file from which the time information is picked 
up.

Original Batch File
(Full Path)

Displays [Original Batch File] of the data file from which the time information is picked 
up.

Description Displays [Description] of the data file from which the time information is picked up.
Processed by Displays [Processed by] of the data file from which the time information is picked up.
Date Processed Displays [Date Processed] of the data file from which the time information is picked up.
Time Processed Displays [Time Processed] of the data file from which the time information is picked up.
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Pop-up Menu
The following menus are displayed when right-clicking on the calibration table view. Displayed menus differ 
when [Calibration Table View] is in the view or edit mode. Unavailable menu items are grayed.

In the view mode

In the edit mode
The different menu items from the view mode are described.

Display Items and Their Order in the Calibration Table
The display items and the font of the calibration table can be set.

1 Right-click in the calibration table view and click [Table Style] from the menu.

Name Description
Copy Copies the selected cells into the clipboard.
Copy Entire Table Copies the entire table into the clipboard.
Select All Selects the entire table.
View Mode A check is displayed in front because the screen is in [View Mode].
Edit Mode Switches to the edit mode.
Export Calibration Table Outputs the calibration table into an ASCII file.
Table Style Allows setting the table style.

Name Description
Pickup Peak Data Picks up retention time information from the data file into the calibration table.
All ON When the selected column is Active or Virtual, all the cells of that column are checked.
All OFF When the selected column contains checkboxes, all the cells are unchecked.
Cut Cuts the selected cells into clipboard.
Copy Copies the selected cells into the clipboard.
Paste Pastes the contents of the clipboard.
Clear Clears the selected cells.
Copy Entire Table Copies the entire table into the clipboard.
Select All Selects the entire table.
Add Row Adds a row at the end of the table.
Insert Row Inserts a row into the current cursor position.
Delete Row Deletes the selected rows.
Sort by Save Time Sorts the table contents by save time.
Data Analysis Parameters Displays the [Data Processing Parameters] dialog.
View Mode Switches to the view mode.
Edit Mode This item is preceded by a check mark because you are in the edit mode.
Cancel Edit Cancels the edit and switches to the view mode.
Import Calibration Table Imports calibration points from an ASCII file into the calibration table.
Export Calibration Table Outputs the calibration table to an ASCII file.
Table Style Allows you to configure the table style.
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2 Click the [Item Settings] tab, and set display items and their order.

3 Click the [Font] tab and set font.

4 Click [OK].

No. Description
Shows items not displayed on the calibration table.
Shows items displayed on the calibration table. Items displayed here are displayed in the calibration 
table starting from the left.
Moves items selected in [Hide Items] to [Display Items].
Moves items selected in [Display Items] to [Hide Items].
Moves the selected [Display Items] up or down.
Returns to the default for [Display Items] and [Hide Items].

No. Description
Enter or select a font name.
Enter or select a style.
Enter or select a size.
Select the text color.
Displays a text preview based on the configured settings.
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3.3.2 Importing Calibration Points from an ASCII File
You can import information including molecular weight and retention time into a calibration table from a file 
that are saved in the ASCII format (such as the CSV format).

1 Click [Edit] in the calibration table view.

2 Right-click in the calibration table view and click [Import Calibration Table] from the 
menu.
The [Import Calibration Curve Table] screen appears.

3 Specify the input file name and items to be imported.

4 Click [OK].
Calibration points are imported from the ASCII file based on the specified setting.

NOTE
The current content of [Calibration Table] is replaced with the content of the ASCII file. 

No. Description
Enter the file name to be imported.
Click this to display the file selection screen.
Select items to be imported. Check the items to be imported from ASCII files and enter the column 
number.
Select a delimiter for items in the input file.
Enter a delimiter when [Other] is selected for [Delimiter].
Specify the row number of the file to be imported where data start.
Click [OK] to import the specified file into [Calibration Table] using above settings.
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3.3.3 Exporting Calibration Table into an ASCII File
You can output the Items that have to be repeatedly entered, such as molecular weight, into an ASCII file 
from the calibration table.

1 Click [Edit] in the calibration table view.

2 Right-click in the calibration table view and click [Export Calibration Table] from the 
menu.
The [Export Calibration Curve Table] screen appears.

3 Set the name and items for the output file.

4 Specify an output file name and items to be output, and click [OK].
Data is output into an ASCII file from the calibration table based on the specified setting.

NOTE
Titles of the specified items are output in the first row. Values for Active and Virtual are in the ON/OFF 
format.

No. Description
Select where to output.
Enter an output file name when you selected [File Name].
Select items to be exported.
Select a delimiter for items in the output file.
Enter a delimiter when [Other] is selected for [Delimiter].
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3.3.4 Picking Up Time of Peak Data from Chromatogram
You can pick up the time of the peak data in a data file into [Calibration Table].

1 Click [Edit] in the calibration table view.

2 Click [Pick up] in [Calibration Table View] in [Edit] mode in the chromatogram view.
The time of the peak data in a data file is copied into [Calibration Table].

Reference
"2.5.4 Picking up Retention Time"

3.3.5 Calculating Calibration Curve
When you switch the calibration table from the edit mode to the view mode, the content of the calibration 
table is confirmed, and then the calibration curve is calculated.
The data is sorted by time, and then the calibration curve information is calculated.

1 Set information required for calculation of the calibration curve in the [Data Processing 
Parameters] screen.

Reference
"3.7 Data analysis parameter"

2 Click [Edit] in the calibration table view.

3 Enter [Time], [Molecular Weight], [Active], [Virtual], and [Weight] in the calibration table.

4 Click [View] in the calibration table view.
The calibration table is confirmed, and the calibration curve information is calculated.
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3.4 Calibration Curve View
Displays calibration curves registered in method files.

3.4.1 Calibration Curve Graph
A calibration curve is displayed in this graph.

Calibration curve graph legend
: Calibration point

s : Calibration point (Average value [Note])
n : Calibration point (Virtual)
Filtration limit value line (Default shown in blue)

NOTE
This is a calibration point of the molecular weight of which the average is calculated when [Time is averaged 
for the same M.W.] on the [GPC Calibration Curve] tab in the [Data Analysis Parameters] screen is checked.

Zooming in graph

When specifying a range by dragging a square on the calibration curve graph, the graph is zoomed in 
according to the specified range.

Adding virtual points

Double-click on the calibration curve graph to register the coordinate in the calibration table as a virtual 
point.

No. Description
Displays factors and identity (R2, R, Dispersion) of the calibration curve.
Displays the time or elution volume and log(M.W.) of the coordinates in real time when placing the mouse on 
the calibration curve graph.
The time and the elution volume can be switched by the axis configuration of the graph.
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Right-click menu

Right-click on the calibration curve graph to display the menu.

Setting the Scale of the Graph
Set the scale of the calibration curve graph.

1 Right-click on the calibration curve graph and click [Scale Settings] from the menu.

2 Configure the settings.

3 Click [OK].

Name Description
Undo Zoom Cancels the previous zooming action.
Redo Zoom Zoom again.
Initialize Zoom Returns the display to the initial state.
Data Processing 
Parameters

Displays the calibration curve tab of the [Data Processing Parameters] screen.

Copy Copies the calibration curve graph image to the clipboard.
Scale Settings Displays the [Scale Setting] screen.
Properties Sets display attributes such as graph color.

No. Description
Select between [Autoscale] and [User Defined] for the scale of the calibration curve graph.
Enter the X axis range of the calibration curve graph.
Enter the Y axis range of the calibration curve graph.
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3.5 Chromatogram View
This view displays chromatograms of data files used to create a calibration curve. The data files are 
registered in the data file list. The chromatogram view has the following three tabs.

3.5.1 Data File List
Data files used when creating calibration curves are displayed in a list. Data files can be added or deleted.

1 Right-click on the chromatogram and click [Data File List] from the menu.

2 Configure the settings.

No. Description
Displays a chromatogram of the selected data.
Overlays all chromatograms in the data file list.
Displays sample information of the selected data.

No. Description
Lists the data files registered in the method file.
Click a file name to make the file selected.
Adding a data file.
Click this button to delete the registration of the data file selected in the data file list.



 LabSolutions GPC Instruction Manual   41

3.5  Chromatogram View

3

3 Click [OK].

NOTE
Select [View] - [Full Path] from the menu on the [Calibration Curve] screen to display file names in full path.

Adding Data Files
Data files to create the calibration curve are added in the data file list.

1 Click [Add] on the [Calibration Curve] screen.
The [Add Data File] screen appears.

2 Select data file to be added, and click [Open].
The selected data file is added to the data file list.

NOTE
Data files can be added if you drag-and-drop them from Data Explorer into the chromatogram view.

Deleting Data Files
Data files to create the calibration curve are deleted from the data file list.

1 Select a data file to be deleted from the data file list.

2 Click [Delete].
The message [Do you remove data file from data file list?] appears.

3 Click [OK].
The selected data file is deleted from the data file list.

NOTE
When swiching file name display, adding or deleting data files, clicking [OK] and closing the 
[Calibration Curve] screen reflect the change.
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3.5.2 [Single] Tab
This tab displays an entire chromatogram of the data file selected from the data files used to create the 
calibration curve.

 

Zooming the Graph
When specifying a range by dragging a square on the chromatogram, the graph is zoomed in according to 
the specified range.

Displaying the Right-click Menu
Right-click on the chromatogram to display the menu.
The displayed menu is as follows:

No. Description
Select a data file to display.

Name Description
Undo Zoom Cancels the previous zooming action.
Redo Zoom Zoom again.
Initialize Zoom Returns the display to the initial state.
Peak Table Displays the peak table of the selected data file.
Manual Integration Bar Displays or hides the manual peak integration bar.
Data File List Displays the [Calibration Curve] screen.
Copy Copies the chromatogram image to the clipboard.
Properties Sets display attributes such as graph color.
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3.5.3 [Multi] Tab
Multiple data files registered in the data file list are overlayed in one graph.

Zooming the Graph
When specifying a range with the mouse on the chromatogram, graph is zoomed in according to the 
specified range.

Displaying the Right-click Menu
Right-click on the chromatogram to display the menu.
The displayed menu is as follows:

3.5.4 [Sample Info.] Tab
Sample information of data files is displayed.

Name Description
Undo Zoom Cancels the previous zooming action.
Redo Zoom Zoom again.
Initialize Zoom Returns the display to the initial state.
Base Shift Displays or hides the base shift.
Data File List Displays the [Calibration Curve] screen.
Copy Copies the chromatogram image to the clipboard.
Properties Sets display attributes such as graph color.
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3.6 Peak table
Peak table of the selected data in the data file list is displayed.

1 Right-click on the chromatogram and click [Peak Table] from the menu.
The peak table is displayed. 

3.7 Data analysis parameter
Parameters related to calculations of calibration curve or molecular weight are set.

1 Click [Data Processing Parameters] from the [Method] menu.

2 Click the [GPC Calibration Curve] tab, and configure the settings.
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3.7  Data analysis parameter

3 Setting Mark Houwink Conversion

1 Check [Mark-Houwink] on the [GPC Calibration Curve] tab.

2 Set the [Mark-Houwink Conversion Parameters] fields.

3 Click [OK].

NOTE

Mark Houwink conversion is performed with the following formula.

logMb = (1 / (1 + b)) log (Ka / Kb) + ((1 + a) / (1 + b)) logMa

Ma: Molecular weight of the standard polymer
Mb: Molecular weight of the unknown polymer

a: Alpha of the standard polymer

b: Alpha of the unknown polymer

Ka : K of the standard polymer
Kb : K of the unknown polymer

No. Description

Select a channel to set the calibration curve information.

Select a calibration curve type.

Enter the filtration limit time.

Check this box to enable the weight setting so that calibration curves are weighted in the calculation.

Check this box to calculate an average value of times of calibration points having the same 
molecular weight in the calibration table and treat it as a single calibration point.

Check this box to enable the Mark-Houwink conversion.

Click this button to open the setting screen for the time conversion.

Check this box to enable the time conversion.

Set parameters used in Mark-Houwink conversion.

No. Description

Set the alpha and K of the standard polymer 

Displays the alpha and K of the unknown polymer. 
(Values set in [GPC Calculation] tab in Data Processing Parameters are fixedly displayed.)
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Setting Time Conversion

1 Check [Time Conversion] in the [GPC Calibration Curve] tab, and click [Settings].

2 Configure the settings.

3 Click [OK].

NOTE
Time conversion is performed with the following formula.
RTc = (time after conversion / time before conversion) RT

No. Description
Enter time before conversion.
Enter time after conversion.
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GPC Calculation

This chapter explains the GPC calculation.

In the GPC calculation, a molecular weight distribution and an average molecular weight of samples 
are calculated from acquired chromatograms and calibration curves.

4.1 Displaying the [GPC Data Analysis] Window

1 Click the  (GPC Data Analysis) icon in the [Main] assistant bar of the [GPC 

Postrun] program.

The [GPC Data Analysis] window appears.
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4.2 Using and Viewing the [GPC Data Analysis] Window
The [GPC Data Analysis] window has [Chromatogram View] and [Molecular Weight Distribution View].

No. Description
Chromatograms and calibration curves are displayed.
Differential and integral molecular weight curves calculated from the chromatogram and the calibration curve 
are displayed.
Click this button (change size button) to switch between the full screen and standard displays.

[Chromatogram View]

[Molecular Weight Distribution View] 
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4.3 Chromatogram View
In [Chromatogram View], the chromatogram and the calibration curve are displayed in layers.

Right-click Menu
When right-clicking on the chromatogram, a menu appears. You can select various operations and settings 
for the chromatogram from the displayed menu.

4.3.1 Display Settings of Chromatograms

Display of Chromatograms
Set the display of the chromatograph.

1 Right-click on the chromatogram, and click [Display Settings] from the displayed menu.

No. Description
Displays the full chromatogram. An area to be zoomed in can be specified by dragging a mouse.
Zooms into a specified area on the chromatogram. An area to be zoomed into can be specified by dragging a 
mouse.
Displays the sample information.
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2 Click the [Chromatogram] tab and set the display of the chromatogram.

NOTE
The range of the horizontal axis of the zoom chromatogram is specified with (min) when the display unit is 
time, and with (mL) when it is the eluent volume.

No. Description
Displays or hides Ch1 through Ch4 chromatograms when the detector is of the dual mode or the PDA detector.
Displays or hides the base shift.
Set the intensity axis unit. The contents and default values displayed in the list vary according to the detector.
Displays or hides the full chromatogram.
Set the height of the full chromatogram on the screen.
When checked, the chromatogram is displayed by adjusting the scale of the intensity axis to 0 V or more.
Select the chromatogram scale on the intensity axis. [Auto-scale to Largest Peak] is selected initially.
When selecting [User Defined], the [Intensity Range] can be set.
When checked, the intensity axis range displayed for all data will be fixed to the set value.
Sets the zoom chromatograms to either an overlaid display or a stacked display.
Displays or hides the chromatogram of another detector. 
When checked, select the other detector.
Allows you to set the upper and lower limits of the intensity axis of the zoom chromatogram for each detector.
When this button is pressed, the display range of the current graph is applied to the range of the zoom 
chromatograms.
Set the upper and lower limits of the time axis of the zoom chromatogram.
Fixes the time axis range displayed for all data to the set value or releases it.
Fixes the intensity axis range displayed for all data to the set value or releases it.
Displays or hides the GPC calibration curve.
Select the GPC calibration curve scale on the intensity axis.
When selecting [User Defined], the [Molecular Weight Range] can be set.
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Display of Status Graphs
Sets the display of the status graphs.

1 Right-click on the chromatogram and click [Display Settings] from the menu.

2 Click the [Status] tab, and set the display of the status graphs.

No. Description
Displays or hides the sample information.
Check items to draw the status curve.
Set the upper and lower limits of the temperature. Click [Normalize] to set the temperature range 
automatically.
Set the upper and lower limits of the pressure. Click [Normalize] to set the pressure range automatically.
Set the upper and lower limits of the flow. Click [Normalize] to set the flow range automatically.
Set the upper and lower limits of the concentration. Click [Normalize] to set the concentration range 
automatically.
Select the unit of measure for the intensity axis on the right-hand side.
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4.3.2 Setting View Properties

1 Right-click on the chromatogram and click [Graph View Properties] from the menu.

2 Click the [General] tab and configure the settings.

No. Description
Displays or hides the X axis grid.
Displays or hides the Y axis grid.
Displays or hides the Y axis intensity value in the exponential format (such as x10 or x100).
Displays or hides the graph comment.
Select either [M.W./D.P] or [log (M.W.) /log (D.P.)] for the scale display when displaying the molecular 
weight information (molecular weight or degree of polymerization) in a graph comment.
When [Show Mouse Position] is checked, the Y-axis coordinate of the mouse will be displayed in the 
intensity value.
Displays or hides the magnification buttons (zoom-in and zoom-out).
Displays or hides the Y axis scroll bar.
Displays or hides the detector and channel names.
Displays or hides the extra curve labels, such as of temperature and pressure.
Displays or hides the peak mark, baseline, fraction collector result and simulation.
Select items to display as peak top comments.
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3 Click the [Color] tab and configure the settings.

4 Click the [Font] tab and configure the settings.

NOTE
The X axis of chromatogram is displayed in time (min) or eluent volume (mL) depending on the 
setting. The Y axis of chromatogram is displayed in log of the molecular weight (M.W.) or log of the 
degree of polymerization (D.P.) depending on the setting.

5 Click [OK].

No. Description
Select a display item for color setting.
Displays the currently set colors.
Click these to set the color of the display item.
Click these to Initialize the color of the display item.

No. Description
Allows you to select an item for the font setting.
Displays the selected [Font Name], [Font Size], and [Font Style].
Displays the [Font] screen for selecting the font.
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4.4 Molecular Weight Distribution View
In [Molecular Weight Distribution View], the molecular weight distribution curves calculated from the 
chromatograms and the calibration curves are displayed. There are two types of molecular weight 
distribution curves: differential and integral.

4.4.1 Display Settings of the Molecular Weight Distribution Curves 

1 Right-click on the molecular weight distribution curve graph and click [Display Settings] 
from the menu.

2 Configure the settings.

3 Click [OK].

No. Description
Displays molecular weight distribution curves.
Displays the correction factor.

No. Description
Select either [Overlay] or [Stack] for the display of the molecular weight distribution graphs (differential 
and integral). These displays are available for multiple detectors or a detector supporting the dual mode.
Displays or hides the integral molecular weight distribution.
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4.4.2 Setting Properties of Molecular Weight Distribution Curve

1 Right-click on the molecular weight distribution curve graph and click [Properties] from 
the menu.

2 Click the [General] tab and configure the settings.

NOTE
The X axis of the molecular weight distribution graph is displayed in the molecular weight log(M.W.) 
or the degree of polymerization log(D.P.) depending on the setting.

3 Click the [Color] tab and configure the settings.

Reference
For details, see step 3 (P.53) in "4.3.2 Setting View Properties".

4 Click the [Font] tab and configure the settings.

Reference
For details, see step 4 (P.53) in "4.3.2 Setting View Properties".

5 Click [OK].

No. Description
Displays or hides the X axis grid.
Displays or hides the Y axis grid.
Switches the display of the Y axis intensity value in the exponential format (such as x10 or x100).
Displays or hides the magnification buttons (zoom-in and zoom-out).
Displays or hides the Y axis scroll bar.
Displays or hides the graph comment.
Select either [M.W./D.P] or [log (M.W.) /log (D.P.)] for the scale display when displaying the molecular 
weight information (molecular weight or degree of polymerization) in a graph comment.
When [Display Y-axis value at intensity.] is checked, the Y-axis coordinate of the mouse will be displayed 
in the intensity value.
Select whether to display the average molecular weight mark for the entire graph or for each peak.
Select the items to be displayed.
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4.4.3 Setting Data Analysis Parameters
Molecular weight distribution is calculated and displayed by setting the data analysis parameters.
Set the following parameters:

• Parameters for samples (Q factor, alpha value, K value)

• Data for GPC calculation (detector, channel)

• Whether or not to perform time correction, its type and necessary factors

• Sensitivity compensation of the RI detector

1 Click [Data Processing Parameters] from the [Method] menu.

2 Click the [GPC Calculation] tab and configure the settings.

No. Description

Enter the element name. Up to 64 characters can be entered. The initial value is blank.

Enter the Q factor. A positive real number can be entered. The initial value is 1.

Enter the alpha value used for Mark Houwink conversion, etc. The initial value is 0.
(Alpha to be displayed for standard polymer are those specified in the [GPC Calibration Curve] tab.)

Enter the K value used for Mark Houwink conversion, etc. The initial value is 1.
(K to be displayed for standard polymer are those specified in the [GPC Calibration Curve] tab.)

Select whether you use the pump flow or a manually input value for the flow calculation. If you use a 
manually input value, set the flow quantity per minute.

Select the molecular weight or the degree of polymerization for the display unit of the Y axis. [Molecular 
weight] is selected initially. By selecting [Degree of Polymerization], you can enter the molecular weight 
per degree of polymerization.

Select a channel of the detector.

Specify whether to perform the GPC calculation for each channel.

Select a method of the time correction. [None] is selected initially.

Specify whether to perform the sensitivity compensation of the RI detector. When performing 
compensation, click [Settings], and set the sensitivity compensation of the RI detector.

Click this to display the [RT/MW Range Setting] screen. Enter the start and end time.
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The Use of the Q Factor
• What is Q factor?

In GPC, components are separated based on the molecular size and a relationship between the elution 
position and the molecular size is set by a formula. When equations differ between the standard sample 
(from which a calibration curve is created) and the unknown sample (for which you want to find out the 
molecular weight), correction is required to obtain accurate molecular weight. The Q factor is used in such 
case.

• How to use the Q factor
Q factor is "molecular weight of each monomer divided by the stretched chain length of each monomer". 
When this value is set, GPC data analysis, such as molecular weight distribution calculation, is done 
using stretched chain length in LabSolutions. Using the default value of 1 means that the calculation is 
done using molecular weight.

• Notational reminder for the use of Q factor
When you use the conversion with the Q factor, you need to interpret the values as [Stretched Chain 
Length] even though they are discrbed as [Molecular Weight] in the following items in LabSolutions.
   - Molecuar weight in a calibration curve table
   - Molecuar weight in a slice data
   - Molecuar weight in a calibration curve graph
   - Molecuar weight in a molecular weight distribution curve
Only average molecular weights displayed in a GPC calculation result are expressed in molecular weight 
that is corrected using the Q factor, not in stretched chain length.

• Reminder on setting when using the Q factor
As explained above, you need interpret values described as molecular weight in a calibration curve table 
as stretched chain length when you use correction with the Q factor. Therefore, specify strethced 
molecular chain length values in the molecular weight cells when creating a calibration curve table.
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Setting the Time Correction
Set the time correction to compensate for variations in the molecular weight distribution calculation due to 
changes in elution time.

1 Check [Internal Standard] or [GPC Control sample] in [Time Correction], and click 
[Settings].

2 Configure the settings.

3 Click [OK].

Reference
"4.5.4 Time Correction Using the Internal Standard Method" on page 67

"4.5.5 Time Correction Using the Control Sample" on page 68

No. Description
Set the retention time of the standard peak used for the time correction.
Standard peak refers to the internal standard peak when using "Internal Standard Method". When using 
"GPC Control Sample", it refers to the peak for data whose batch processing sample type is set to “GPC 
Control Sample”.
Set the band of the standard peak.
Set the base time (T0) used for the time correction calculation. Usually, zero or T.LIMIT (filtration limit 
time) is set.
Select whether to also calculate the internal standard peak in the molecular weight calculation.



 LabSolutions GPC Instruction Manual   59

4.4  Molecular Weight Distribution View

4

Sensitivity Compensation Setting of RI Detectors
Since the RI detector has a characteristic that the sensitivity lowers if the molecular weight of analyzed 
sample is low, perform the sensitivity compensation by setting the sensitivity compensation parameters.
To use this function, it is necessary to ascertain the relationship between the molecular weight and the 
response sensitivity (area) as described in "4.5.6 Sensitivity Compensation of RI Detectors".

1 Check [Sensitivity Compensation (RID)] and click [Settings].

2 Configure the settings.

3 Click [OK].

NOTE
The table contents can be copied and cut using the right-click menu.

No. Description
Set the base area. Set a value equal to or greater than the maximum value of the sensitivity 
compensation table area.
The area value correction factor is calculated with the following:
• Correction factor = (base area) / (Area value of the molecular weight on the graph)
This is the mapping table of the molecular weight and the area values. A maximum of 20 lines can be 
entered and must monotonically increase.
When clicked, the contents of the sensitivity compensation table are drawn in the graph in .
Displays the sensitivity compensation graph.
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Setting the RT/MW Range
Specify ranges for performing GPC calculation.

• You can specify multiple (up to 20) ranges in the chromatogram or the molecular weight distribution graph.
• You can specify time (molecular weight) by entering numbers or clicking on the graph.

1 Click [RT/MW Range Setting].
The [RT/MW Range Setting] screen appears.

2 Configure the settings.

3 Click [OK].

NOTE
• When the RT/MW ranges are already set in the calibration curve screen, the setting is reflected by 

default.

• The table contents can be copied and cut using the right-click menu.

No. Description
Switches the graph to the chromatogram or the molecular weight distribution curve.
Displays the chromatogram or the molecular weight distribution curve.
Displays the set RT/MW ranges. Enter values in [Start Time] and [End Time] or [Min. Molecular Weight] 
and [Max. Molecular Weight] to specify the RT/MW range settings.
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4.4.4 Displaying Slice Data
The slice data, an intermediate step of the molecular weight calculation, is displayed.

• The slice information of the specified peak is displayed at a specified interval.
• Items to be displayed and their order can be customized in the table style setting.
• Selected items can be transferred to the clipboard.

1 Click [Slice Data] from the [View] menu.

2 Configure the settings.

3 Click [Close].

NOTE
• [Slice Data] can be selected from the [View] menu only when [Calculate GPC] is checked in the [GPC 

Calculation] tab of the [Data Processing Parameters] screen.

• Changing the output interval ([Steps]) of the slice data does not alter the numbers displayed in the 
left-most [#] column.

No. Description
Select a channel of the detector.
Select [Total] or any of the peak numbers.
Specify an interval to display the slice data.
Displays data of each slice at the specified interval.
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Setting the Table Style
The table style of the slice data is set as follows:

1 Right-click on the data table in the [Slice Data] tab, and click [Table Style] from the 
menu.

2 Click the [Item Settings] tab and configure the settings.

3 Click the [Font] tab and configure the settings.

No. Description
Hidden items are displayed.
Displayed items are displayed.
Moves items selected in [Hide Items] to [Display Items].
Moves items selected in [Display Items] to [Hide Items].
Click these to move a selected item in [Display Items] up or down.
Returns [Display Items] and [Hide Items] to their default status.
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4.4.5 Displaying the Results from the Peak Table
The peak information or the detailed information for individual peaks are displayed.

• The peak information (retention time, height, etc.) is listed.
• Detailed information (values at the start, top, and end) of the selected peak is displayed.
• Items to be displayed and their order can be customized in the table style setting.
• Selected items can be transferred to the clipboard.

1 Click [Peak Table] from the [View] menu.

2 Check the items.

No. Description
Enter or select a font name.
Enter or select a font style.
Enter or select a font size.
Select a text color.
Character display sample based on the setting is displayed.

No. Description
Lists the peak information of the currently selected detectors and channels.
Displays the detailed information of the selected peak.
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Setting the Table Style

Reference
"4.4.4 Displaying Slice Data", "  Setting the Table Style"

NOTE
Operations are the same for any table, but the displayed items and hidden items are different.

4.4.6 Displaying the Result of the Average Molecular Weight
The average molecular weight is displayed by each peak.

• Average molecular weight of all the peaks and of individual peaks can be calculated.
• Items to be displayed and their order can be customized in the table style setting.
• Selected items can be transferred to the clipboard.

1 Click [Molecular Weight Distribution Table] from the [View] menu.

2 Check the items.

The average molecular weight, the polydispersity, and the intrinsic viscosity of the all the peaks and of individual 
peaks is listed. Items to be displayed and their order can be customized in the table style setting.
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Setting the Table Style

Reference
"4.4.4 Displaying Slice Data", "  Setting the Table Style"

NOTE
Operations are the same for any table, but the displayed items and hidden items are different.

4.4.7 Displaying the Result of the Average Molecular Weight of the RT/MW Ranges
The average molecular weight values of the RT/MW ranges are displayed.

• Average molecular weight can be calculated for each specified RT/MW range.
• Items to be displayed and their order can be customized in the table style setting.
• Selected items can be transferred to the clipboard.

1 Click [RT/MW Table] from the [View] menu.

2 Check the items.

The average molecular weight, the polydispersity, and the intrinsic viscosity of each RT/MW range is listed. 
Items to be displayed and their order can be customized in the table style setting.
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Setting the Table Style

Reference
"4.4.4 Displaying Slice Data", "  Setting the Table Style"

NOTE
Operations are the same for any table, but the displayed items and hidden items are different.

4.5 GPC Calculation
A chromatogram is converted into a molecular weight distribution using an approximate equation, and 
various average molecular weight values are calculated from the molecular weight distribution.
The following time corrections are performed in the conversion to the molecular weight distribution.

• Correction using the internal standard method
• Correction using the control sample
• Sensitivity compensation of RI detectors

4.5.1 Approximate Equations for Calibration Curves
The following approximate equations are used for obtaining molecular weights from the chromatograms.

X = x(elution duration) - T.LIMIT(filtration limit time)
M: the molecular weight or the chain length

Type Equation
Point-to-point Linear interpolation between calibration points
Linear (Straight line) log M = aX + b
3rd order log M = aX3 + bX2 + cX + d
3rd order + Hyperbolic curve log M = aX3 + bX2 + cX + d + e/X2

5th order log M = aX5 + bX4 + cX3 + dX2 + eX + f
5th order + Hyperbolic curve log M = aX5 + bX4 + cX3 + dX2 + eX + f + g/X2

7th order log M = aX7 + bX6 +cX5 + dX4 + eX3 + fX2 + gX + h
7th order + Hyperbolic curve log M = aX7 + bX6 +cX5 + dX4 + eX3 + fX2 + gX + h + i/X2
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4.5.2 Equations for Calculating Average Molecular Weight

Hi: Peak height 
Mi: Molecular weight or chain length 
α/K : Constant and Index of the viscosity equation 
QF: Q factor (1 for molecular weight)

4.5.3 Time Correction
The following time correction can be performed in conversion to the molecular weight distribution:

• Correction using the internal standard method
• Correction using the control sample

4.5.4 Time Correction Using the Internal Standard Method
A chromatogram is measured after adding the internal standard sample to the unknown sample that is to be measured. 
The time axis of the actual chromatogram is corrected using the peak of the internal standard sample of which retention 
time (Tis) is known. The corrected chromatograms are expanded or reduced along the time axis.

Type Equation
Number average Mn

Weight average Mw

Z Average Mz

Z+1 Average Mz1

Viscosity average Mv

Intrinsic viscosity   I.VISC = K × (Mv)α

Mn =                         ×QF
ΣHi

Σ(Hi/Mi)

Mw =                         ×QF
Σ(Mi × Hi)

ΣHi

Mz =                        ×QF
Σ(Mi2 × Hi)
Σ(Mi × Hi)

Mz1 =                       ×QF
Σ(Mi3 × Hi)
Σ(Mi2 × Hi)

Mv =                                      ×QFΣ(Hi × Mi α)
ΣHi( )1/α

[Before correction]
t1

Internal standard peak

tis

Standard time T0

T0 +                   　 　   × (t1-T0)
Tis - T0

tis - T0

Tis

[After correction]

t

t

Band

Set time Tis

NOTE
Time before base time T0 is not corrected.
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4.5.5 Time Correction Using the Control Sample
In this method, analysis is done using samples at the internal standard peaks as the GPC control samples. 
As shown in the following figure, GPC control samples are injected among unknown samples in a batch 
schedule, and the correction values are continually updated.

4.5.6 Sensitivity Compensation of RI Detectors
RI detectors have a characteristic that the sensitivity lowers when the molecular weight is low. When the molecular 
weight distribution of the measuring sample is broad, sensitivity change of the RI detector affect the result.
First, a sample that is a mixture of equal quantity of standard samples that have different molecular weights 
is analyzed, and the area values for each molecular weight are calculated. The area to be standard is 
pre-determined, and the relationship between each molecular weight and the area is defined as shown in 
the following figure.

Molecular weight calculation is performed using a value obtained by multiplying the response amount (the 
slice value), a molecular weight M, by b/a.

Schedule

GPC control
sample

GPC control
sample

Unknown
sample

Unknown
sample

Unknown
sample

Unknown
sample

Set time

GPC control
sample

Peak of control sample

Before correction
(Unknown sample)

After correction
(Unknown sample)

NOTE
Time before base time T0 is not corrected.

Standard area value

Area

M Molecular weight

a

b (Standard area)
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GPC Data Comparison

In the [GPC Data Comparison] window, the GPC molecular weight calculation results from multiple 
data files can be displayed in layers as one graphed view, and the statistical calculations are 
performed. GPC data comparison is performed per detector/channel. When a data file contains 
multiple calculation results of molecular weight distribution, you can specify a detector/channel and 
display the data in one graph.

5.1 Displaying the [GPC Data Comparison] Window

1 Click the  (GPC Data Comparison) icon in the [Main] assistant bar of the [GPC 

Postrun] program.

The [GPC Data Comparison] window appears.
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5.2 Using and Viewing the [GPC Data Comparison] Window
The [GPC Data Comparison] window contains [Data List View], [Chromatogram View], [Molecular Weight 
Distribution View], and [Cumulative Percent View].

No. Description
A data list for the GPC data comparison is displayed.
Chromatograms are displayed in layers.
Differential molecular weight distribution curves are displayed in layers.
Integral molecular weight distribution curves are displayed in layers.
Click this button (change size button) to switch between the full screen and standard displays.

[Data List View] [Molecular Weight Distribution View]

[Chromatogram View] [Cumulative Percent View]
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5.3 Data List View
A list of data for the GPC data comparison is displayed in [Data List View].

5.4 Chromatogram View
Chromatograms of data registered in [Data List View] are displayed in layers in [Chromatogram View].

NOTE
Dragging on the chromatogram to specify the range will zoom in on that range.

No. Description
Data files are numbered in the order registered.
Data file names are displayed.
Detector/channel names are displayed.
Names of the method files that were used to measure the data are displayed.
Sample names of data files are displayed.

No. Description
Click to shift the chromatograms in the X axis direction using the mouse.
Displays the data list numbers, data file names, detector names, and channel names in the graph display colors. 
The time (or amount of elution) and the intensity (%) at the mouse position when the mouse is located on the 
graph.
(The time and the amount of elution can be switched by the axis configuration of the graph.)
Marker lines.
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5.4.1 Display of Marker Lines
Two marker lines are displayed on the left and right of the chromatogram. They can be moved along the X 
axis by dragging them. This forces the marker lines of the differential molecular weight distribution and the 
integral molecular weight distribution curves automatically move to the corresponding new positions. Also, 
by dragging the marker line on the differential or integral molecular weight distribution graphs you can view 
the corresponding position on the chromatogram.

NOTE
When the chromatograms are overlayed using different calibration curves, marker lines are displayed but 
they are not functional.

5.4.2 Shifting Chromatograms
There are two methods to shift chromatograms in the X axis direction: setting the shift time in the [Shift 

Chromatogram Data] screen and using the (Move Left/Right) button.
The corresponding differential molecular weight distribution curve graph and integral molecular weight 
distribution curve graph are shifted accordingly.

Using the [Shift Chromatogram Data] Screen

1 Right-click in the chromatogram view and click [Move Left/Right] from the menu.

2 Configure the settings.

3 Click [OK] or [Apply].
The chromatogram is shifted according to the time specified in the total shift time.

No. Description
Select a data file name to shift.
Numbers and file names registered in the data list are displayed in the combo box.
Displays the shift time from the initial state. You can also directly enter the shift time.
The X axis scale indicates the total shift time (min) or the total shift elution amount (mL).
The total shift time is increased or decreased from the current position only by the unit specified in 
[Shift Time].
The unit used for increasing and decreasing in  can be selected from among [0.00001], [0.0001], 
[0.001], [0.01], [0.1] and [1.0].
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Using the Move Left/Right Button

1 Click the  (Move Left/Right).
It becomes as if the button is held down.

2 Drag from the start position to the end position on the chromatogram.
Placing the cursor on the chromatogram will display a vertical line. Drag to specify a range.
The selected data of the chromatogram will be shifted, and the corresponding graph of the differential 
molecular weight distribution curve and the graph of the integral molecular weight distribution curve will 
also be shifted.

5.4.3 Display Settings of Chromatograms
Display settings for [Chromatogram View] are performed as follows:

1 Right-click on the chromatogram and click [Display Settings] from the menu.

2 Configure the settings.

3 Click [OK].

No. Description
Select the display method of the Y axis scale of the chromatogram.
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5.4.4 Setting View Properties

1 Right-click on the chromatogram and click [Properties] from the menu.

2 Click the [General] tab and configure the settings.

3 Click the [Color] tab and configure the settings.

No. Description
Displays or hides the X axis grid.
Displays or hides the Y axis grid.
Displays or hides the graph comments.
When [Display Y-axis value at intensity.] is checked, the Y-axis coordinate of the mouse will be 
displayed in the intensity value.
Displays or hides the magnification buttons (zoom-in and zoom-out).
Displays or hides the Y axis scroll bar.
Displays or hides the detector and channel names.

No. Description
Allows you to select a display item, such as [Graph Background] or [Graph Frame], for the color setting.
Displays the color set for the selected display item.
Sets the color of the selected display item.
Click this to set the color of the display item.
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4 Click the [Font] tab and configure the settings.

5 Click [OK].

No. Description
Allows you to select an item for the font setting.
Displays the selected [Font Name], [Font Size], and [Font Style].
Displays the [Font] screen. Select a font.



5  GPC Data Comparison

76   LabSolutions GPC Instruction Manual

5.5 Molecular Weight Distribution View
In [Molecular Weight Distribution View], differential molecular weight distribution curves of data registered 
in the data file list are displayed in layers.

NOTE
You can zoom in on an area on the differential molecular weight distribution curve graph by dragging a 
square to specify the area.

5.5.1 Display of Marker Lines
Two marker lines are displayed on the differential molecular weight distribution curve graph. They can be 
moved along the X axis by dragging them. This forces the marker lines of the chromatogram and the 
integral molecular weight distribution graph move automatically with them.

5.5.2 Display Settings of the Differential Molecular Weight Distribution Curve 

Reference
"5.4.3 Display Settings of Chromatograms" on page 73

No. Description
Displays the data list numbers, data file names, detector names, and channel names in the graph display colors. 
Displays the molecular weight (or degree of polymerization) and its percentage at the mouse position if the 
mouse is located on the graph.
These are displayed in conjunction with the marker lines of the chromatogram.
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5.5.3 Setting View Properties

1 Right-click on the differential molecular weight distribution curve graph, and click 
[Properties] from the menu.

2 Click the [General] tab and configure the settings.

3 Click the [Color] tab and configure the settings.

Reference
For details, see step 3 (P.74) in "5.4.4 Setting View Properties".

4 Click the [Font] tab and configure the settings.

Reference
For details, see step 4 (P.74) in "5.4.4 Setting View Properties".

5 Click [OK].

No. Description
Displays or hides the graph comments. Select either [M.W./D.P] or [log (M.W.) /log (D.P.)] for the 
scale display when displaying the molecular weight information (molecular weight or degree of 
polymerization) in a graph comment. When [Display Y-axis value at intensity.] is checked, the Y-axis 
coordinate of the mouse will be displayed in the intensity value.
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5.6 Cumulative Percent View
In [Cumulative Percent View], integral molecular weight distribution curves of data registered in the data file 
list are displayed in layers.

NOTE
You can zoom in on an area on the integral molecular weight distribution curve graph by dragging a square 
to specify the area.

5.6.1 Display of Marker Lines
Two marker lines are displayed on the integral molecular weight distribution curve graph. They can be
moved along the X axis by dragging them with a mouse while the marker lines of the chromatogram
and the differential molecular weight distribution curve graph are moved as well.

No. Description
Displays the data list numbers, data file names, detector names, and channel names in the graph display colors. 
Displays the molecular weight (or degree of polymerization) and its percentage at the mouse position if the 
mouse is located on the graph.
These are displayed in conjunction with the marker lines of the chromatogram.
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5.6.2 Setting View Properties

1 Right-click on the integral molecular weight distribution curve graph, and click 
[Properties] from the menu.

2 Click the [General] tab and configure the settings.

3 Click the [Color] tab and configure the settings.

Reference
For details, see step 3 (P.74) in "5.4.4 Setting View Properties".

4 Click the [Font] tab and configure the settings.

Reference
For details, see step 4 (P.74) in "5.4.4 Setting View Properties".

5 Click [OK].

No. Description
Displays or hides the graph comments.
Select either [M.W./D.P] or [log (M.W.) /log (D.P.)] for the scale display when displaying the molecular 
weight information (molecular weight or degree of polymerization) in a graph comment.
When [Display Y-axis value at intensity.] is checked, the Y-axis coordinate of the mouse will be 
displayed in the intensity value.
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5.7 Statistical Calculation Result

1 Click [Statistical Calculation Results] from the [View] menu.

2 Configure each setting.

3 Click [OK].

NOTE
The display items are set in the [Table Style] screen. When all data cannot be displayed in the data list grid 
display area, the vertical and horizontal scroll bars are used to scroll the table.

No. Description
Select either [Total] or [Optional Area] for the display of the statistical results.
Select the No. to display when [Optional Area] is selected in the type.
Displays the data list and statistical calculation results. The display items can be specified in [Table 
Style]. The maximum number of data for the GPC data comparison is 10.
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5.7.1 Setting the Display Items of the [Statistical Calculation Result] Screen

1 Right-click on the data table in the [Statistical Calculation Results] screen, and click 
[Table Style] from the menu.

2 Click the [Item Settings] tab and configure the settings.

3 Click the [Font] tab and configure the settings.

4 Click [OK].

No. Description
Moves items selected in [Hide Items] to [Display Items].
Moves items selected in [Display Items] to [Hide Items].
Click these to move a selected item in [Display Items] up or down.

No. Description
Enter or select a font name.
Enter or select a font style.
Enter or select a font size.
Select a text color.
Character display sample based on the setting is displayed.
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6

Report Function

This chapter describes the report function of LabSolutions GPC software.
In addition to the LC Real Time Analysis print items, the following GPC analysis print items are available.

• GPC calibration curve item
Allows you to print a calibration curve, a calibration curve table, and calibration curve correction parameters.

• GPC graph item
Allows overlay printing of a chromatograph and a calibration curve, as well as a differential and an integral 
curves, from a data file.

• GPC overlay item
Allows overlay printing of the same type of curves from multiple data.

• GPC calculation result item
Allows printing of slice information, peak information, and average molecular weight information.

• GPC summary item (molecular weight statistic values of multiple data)
Allows you to print molecular weight statistic values from multiple data.

• Method (GPC parameters)
Allows printing of GPC method parameters.

Click any of the following icons to select the items.

No. Icon Item
GPC calibration curve

GPC graph

GPC overlay

GPC calculation result

GPC summary

Method
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6.1 Creating Reports
Create a GPC analysis result report as follows:

1 Click  (Report Format) in the [Main] assistant bar of the [GPC Postrun] program.

2 Click the print item you would like to paste.

For example, click  (GPC Calibration Curve).
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6

3 Select the area where you wish to paste the print item.
On the report creation screen, drag the cursor from the starting point to the ending point of the area where 
you wish to paste the print item (the calibration curve).

4 Specify the print item format.
Set the print position, the size, the font, etc. on the [General] tab.

No. Description
Specify the distance from the upper left corner of the report paper in mm with the [Left] and [Top] print 
positions.
Specify the size (in mm) of the print item in [Width] and [Height].
Displays the font used for printing.
Check [Enable] to display the report with a title.
Select an item to set a color for.
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5 Click the [File] tab, and specify a file for the print item.

6 Click [OK].
The print item is displayed on the report creation screen. 

If you wish to change the position or size of the print item displayed, display the property again and make 
necessary changes.

Click  (Print) on the [Report] assistant bar to print the created report.

NOTE
When you drag and drop a data file from [Data Explorer] to the report creation screen, the actual data 
is imported and displayed on the report creation screen.

No. Description
Specify a file name to print a report.
Check this box to fix the file to print.
Click this to display the file selection screen.
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6.2 GPC Calibration Curve Item
The calibration curve information used for GPC analysis is laid out on the report as follows:
The header, the calibration curve graph, and the calibration curve table can be configured separately.

No. Description
Header (Calibration curve correction parameters and calibration curve equation information are 
displayed.)
Calibration curve graph
Calibration curve table
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Setting Position
Positions of the graph and the table in the GPC calibration curve item are set.

1 Right-click on an item pasted on the report, and click [Properties] from the menu.
Double-clicking the item also displays the screen.

2 Click the [Position] tab and configure the settings.

No. Description
Select a detector and a channel to be printed from the combo box.
Check [Fix Detector Ch No.] to fix the detector number.
Check this box to display the header and calibration curve correction parameters.
Check this box to print the calibration graph. Set the width of the graph optionally. If you make the 
graph width bigger, the table width becomes smaller.
Check this box to display the calibration table.
Check this box to set the position and size of the graph and the table individually.
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Setting the Header
Set what is to be printed in the header.

1 Click the [Header] tab and configure the settings.

No. Description
Enter and edit letters to be printed.
Click to restore the text edit area to the initial values.
Select how you want to align the text in the item frame from the list.
Specify the number of spaces for a tab stop. Click [t] or [s] on the right side or directly enter a 
desired numeric value.
Variables can be inserted into the header information. Select them from the variable list. After 
selecting, click [Insert] to insert the variable at the cursor position in the text edit area.
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Setting a Graph
Specify how to print out the calibration graph as follows:

1 Click the [Graph] tab and configure the settings.

No. Description
Specify the axis types and axis names to be printed on the graph. Check [X] or [Y] to display the 
graph scale of the axis. $CalibXAxis$ and $CalibYAxis$ can be used as axis names.
Check these boxes to print a title for each position.
Check this box to display grid lines.
Check this box to display a calibration point number on each calibration point.
Select the mark type of the calibration points.
Check this box to fill the marks when [Circle] or [Square] is selected in [Mark Type].
Select the horizontal axis of the graph.
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Setting the Table
Set the print format of the calibration table as follows:

1 Click the [Table] tab and configure the settings.

No. Description
Move the item selected in [Hide Items] to [Display Items].
Move the item selected in [Display Items] to [Hide Items].
Move the item selected in [Display Items] up or down.
Select a column name to be displayed in the column index row.
Select the display position for an item from the list.
Set the number of characters that can be referred to.
Set the width of the column.
Click this to display the [Format Settings] screen. (See below)
Check to display the column index.
Set the cell height.
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Setting the format
Set the data format to display in the item frame related to table as follows:
In the properties of the item frame for printing information in a table format, such as in a peak table, click 
[Format] in the [Format] tab or [Table] tab to display the [Format] screen.

NOTE
[Format] is enabled when one item of the [Display Items] is selected.

No. Description
Enter characters to be added in the front of data.
Enter characters to be added in the back of data, such as unit.
Set the format related to values.
Check the box to enable the number-of-decimal-digits setting, and enter the number in the text box.
Select the way to round numbers.
Check this box to enable the minimum data length setting. Then enter the minimum data length for 
the data.
Set the placement within the display range for when the value is less than the minimum data length.
From the list displayed by clicking [t] on the right side, select characters to fill in blank digits for the 
data shorter than the minimum length.
Set characters to replace the value if it is 0 (zero).
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6.3 GPC Graph Item
This item is used to create the print layout for graphs used for GPC analysis.

• Chromatogram
• Calibration curve
• Differential molecular weight curve
• Integral molecular weight curve

These curves in a data file can be output in two graphs.
Combinations which you can overlay are as follows.

• Chromatogram and calibration curve
• Differential curve and integral curve (The horizontal axis is the molecular weight.)

Setting Graphs to Be Output
Set graphs to be output on report as follows:

1 Right-click on an item pasted on the report and click [Properties] from the menu.
Double-clicking the item also displays the screen.

2 Click the [Graph] tab, and configure the settings.

No. Description
Select a detector and a channel of chromatogram to be output.
Check [Fix Detector Ch No.] to fix the detector number.
Check this box to display the chromatogram.
Check this box to display the calibration curve.
Check this box to display the differential curve.
Check this box to display the integral curve.
Select the display unit (min. or mL) of the horizontal axis of the graph.
Check to display annotations. Click [Details] to set the content to be displayed as annotations.
Check these boxes to display the baseline or peak detection marks on the chromatogram.
Check [RT/MW Range Mark] to display marks for the RT/MW range segment. 
Check to display the average molecular weight on the graph. The calculation method for the average 
molecular weight can be selected from either the detection peak unit or from the entire chromatogram. 
Check [Draw Average Molecular Weight Mark] to draw a mark noting the average molecular weight.
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6.4 GPC Overlay Item
This item is used to overlay graphs of the channel to which the GPC calculation is specified to be done from 
multiple data files. This is used when you wish to compare chromatograms or differential curves.

NOTE
• Different types of curves, such as differential curves and integral curves, cannot be overlayed on a 

graph.

• Reports with GPC overlay items can be output from the [Report Generator] window.

Setting Graphs to Be Output
Select the type of curves to be overlayed, and specify the output channels.

1 Right-click on an item pasted on the report and click [Properties] from the menu.
Double-clicking the item also displays the screen.

2 Click the [Graph] tab in the [GPC Overlay Properties] screen, and configure the settings.

No. Description
Specify channels to print report.
Check [Fix Detector Ch No.] to fix the detector number.
Select the way to set x-axis display range, automatically or manually.
Specify the graph output range in time, molecular weight, or log(molecular weight).
Check this box to display grid lines in the graph.
Select one from chromatogram, molecular weight distribution curve, and cumulative percent curve.
Check to display annotations. Click [Details] to set the content to be displayed as annotations.
Select the horizontal axis of the graph.
Select the way to display the graph. This selection is disabled for a cumulative percent curve.
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6.5 GPC Summary Item
This item is used to perform statistical calculations with molecular weight calculation results from multiple 
data and to calculate and output the statistics (average, %RSD, maximum value, minimum value, and 
standard deviation) to report.
You can select whether to perform statistical calculations by chromatogram or RT/MW range.
Statistical calculations are performed for the following molecular weight calculation results.

• Number average molecular weight (Mn)
• Weight average molecular weight (Mw)
• Z average molecular weight (Mz)
• Z+1 average molecular weight (Mz1)
• Viscosity average molecular weight (Mv)
• Mw/Mn
• Mv/Mn
• Mz/Mw
• Intrinsic viscosity

Printing by chromatogram
Statistical calculation is performed with the total molecular weight of the channel in which "GPC 
Calculation" is enabled at the selected channel, and statistic values are output in the following print image. 

Printing by RT/MW range
Various types of average molecular weight are displayed by RT/MW range of the channel in which GPC 
calculation is enabled, and the statistic values are output. Since you can set multiple RT/MW ranges for a 
channel, statistical calculations are performed in the ascending order of the retention time of each channel. 

• RT/MW range mapping image

The time range of RT/MW range set by data differs, but statistical calculations are performed by RT/MW 
range where the retention time is short, and the results are output.
Output image

You can configure which
statistical calculation values
should be included in the table. 

Adding data files
increases number of
these rows.
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Setting Summary Output
Select the statistical values for the output and whether the output is by chromatogram or by RT/MW range.

1 Right-click on an item pasted on the report and click [Properties] from the menu.
Double-clicking the item will also display the [Properties].

2 Click the [Output] tab, and configure the settings.

No. Description
Specify the channel to be output. Check [Fix Detector Ch No.] to fix the detector number.
Check this box to display the chromatogram.
Set the chromatogram to be output by [Each Data], [Each Detector], or [Each Channel].
Set the lateral arrangements of the chromatogram. You can also set the width between the blocks.
Check to display the summary table. Specify the output unit as either [Each Chromatogram] or [Each 
RT/MW]. You can also specify the display ratio of the chromatogram and the table.
Check this box to display data file names in the title column with their paths.
Check [Baseline] to connect peak baselines with a line.
Check [Peak Detection Mark] to display peak detection marks.
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Setting Summary Table (Column Setting)
Set column configuration of the summary calculation result table as follows:

1 Click the [Summary Table] tab, and configure the settings.

No. Description
Move the item selected in [Hide Items] to [Display Items].
Move the item selected in [Display Items] to [Hide Items].
Move the item selected in [Display Items] up or down.
Select a column name to be displayed in the column index row.
Select the display position for an item from the list.
Set the number of characters that can be referred to.
Set the width of the column.
Click to display the [Format] screen.
Check this box to display the column index.
Set the cell height.
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Setting Summary Table (Setting Title)
Set row configuration of the summary calculation result table as follows:

1 Click the [Summary Table Title] tab, and configure the settings.

No. Description
Move the item selected in [Hide Items] to [Display Items].
Move the item selected in [Display Items] to [Hide Items].
Move the item selected in [Display Items] up or down.
Set the title to be displayed in the row index column (leftmost column).
Select the display position for an item from the list. (Position setting is available only for %RSD.)
Click to show the [Format] screen. (Format setting is available only for %RSD.)
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Setting Files
Set the list of data files to create a summary.

1 Click the [File] tab, and configure the settings.

No. Description
Click to display the [Open File] screen. Select the data files.
Displays a data file list.
Check this box for a fixed file name to print.
Click this to remove the file selected in the data file list from the calculation target, and delete it from 
the list.
Click the [Up] or [Down] to change the order of files in the data file list.
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6.6 Method Item

Method parameters of the GPC analysis can be output from the conventional method report items.
Following parameters that are necessary for GPC analysis are output.

• Title

• Element name

• Q factor

• Alpha value

• value

• Flow setting

• Flow value

• Molecular weight distribution

• Molecular weight per degree of polymerization

• Channel number

• Filtration limit time

• Time correction method

• Time correction parameters

• Delay time correction

• Sensitivity Compensation of RI Detectors

• RT/MW range setting

 GPC Parameters

1 Right-click on an item pasted on the report and click [Properties] from the menu.

2 Click the [Data Processing Parameters] tab and configure the settings.

NOTE

The GPC items are [GPC Parameters] and [GPC Method].
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Setting [Details of GPC Parameters]
Set the output items for method information set as GPC parameters.

1 Select [GPC Parameters] from the [Display Items], and click [Detail].

2 Configure the settings.

NOTE
All items are [Display Items] by default.
Move items that should not be output to [Hide Items] and click [OK].

Setting [Details of GPC Methods]
Set the output items for method information for each channel set as the GPC method.

Reference
See "  Setting [Details of GPC Parameters]" for operation of the [Detail] screen of the GPC methods.
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6.7 GPC Calculation Result
Slice information, peak information, and various average molecular weight information are output as the 
GPC calculation result. The calculation result can be output by peak or RT/MW range.
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Output Setting
Select whether the GPC calculation result is output by peak or by RT/MW range. You can also select 
calculation result items of slice information, peak information or average molecular weight.

1 Right-click on an item pasted on the report and click [Properties] from the menu.

2 Click the [Output] tab, and configure the settings.

No. Description
Select whether the calculation result is printed by peak or by RT/MW range.
Select items to display as calculation result. Uncheck all to display only titles such as peak number 
or RT/MW range number.
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Slice Information
Set the display format of the slice information as follows: You can set the display format by grid.

1 Click the [Slice Data Information] tab, and configure the settings.
The [Slice Data Information] screen appears.

No. Description
Move the item selected in [Hide Items] to [Display Items].
Move the item selected in [Display Items] to [Hide Items].
Move the item selected in [Display Items] up or down.
Select a column name to be displayed in the column index row.
Select the display position for an item from the list.
Set the width of the column.
Click to display the [Format] screen.
Check this box to display the column index.
Set the cell height.
You can select whether to display all of the slice information or to skip a certain number of slices.
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Peak Information
Set each title of the peak information data.

1 Click the [Peak Information/Range Information] tab, and configure the results.

No. Description
You can select title items of the peak information and change the titles.
Start: Peak start time, Top: Peak top time, End: Peak end time
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Average Molecular Weight
Set the print output format of the average molecular weight result.

1 Click the [Average Molecular Weight] tab, and configure the settings.

No. Description
You can select fonts of the molecular weight result to be output. You can emphasize the molecular 
weight result by selecting fonts.
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GPC File Converter

The GPC file converter provides the following functions:
• Importing of method files created by CLASS-LC10/CLASS-VP GPC software
• Creation of files by merging a LabSolutions method file and a CLASS-LC10/CLASS-VP GPC method file

The conversion items in a file are as follows:
• User who created the file, date created, comment
• GPC parameters (such as GPC parameters, correction parameters, RT/MW range table)
• Calibration curve information

7.1 Importing a Method File
Import the information of a CLASS-LC10/CLASS-VP GPC method file by opening it.
Information of a CLASS-LC10/CLASS-VP method file is imported to the current detector channel.

1 Click [Import CLASS GPC Method File] from the [File] menu in the [GPC Calibration 
Curve] window.



7  GPC File Converter

108   LabSolutions GPC Instruction Manual

2 Select a CLASS GPC method file and click [Open].
A CLASS-LC10/CLASS-VP GPC method file is opened.

7.2 Merging GPC Method Files
Create a new LabSolutions method file by merging an existing LabSolutions method file and a 
CLASS-LC10/CLASS-VP GPC method file.
Information of a CLASS GPC method file is deployed to all the channels of detectors in a LabSolutions method file.

1 Click [Merge of CLASS GPC Method File] from the [File] menu of the [GPC Calibration 
Curve] window.
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2 Specify file to be merged and click [Merge].

NOTE

• When you select or input the name of an existing file in , the file is overwritten.

• If there are multiple files you wish to merge, repeat the above.

3 Click [Close].
If the audit trail setting is enabled with a method file, a CLASS-LC10/CLASS-VP GPC method file cannot 
be merged with it.

No. Description
Select or input [Method file(LabSolutions)].
Select or input [CLASS GPC method file].
Select or input [Output method file name(LabSolutions)].
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Appendix

This chapter details help for problems with software operation, the method for checking the content of 
online manuals, and information on LabSolutions GPC specifications.

8.1 When Having Problems with the Operation
This software provides the help menu and online manuals. Use these for any uncertainties in operation and 
the terms on the screen.

8.1.1 Using Help
To check the help for this software, open the help using one of the following methods.

Searching by Keyword
For unfamiliar terms and parameters, enter a keyword and search. A list of topics matching the keyword 
will be displayed. You can view the help that matches the term or parameter from the topic.

1 Open the help.

2 Click the [Index] tab, and perform a search.

Operation Type Operation Method
[Help] Click [Help] on the screen. 

Display the help for the open window.
(Contents) Click  (Contents) in the toolbar.

[Help] menu Click [Contents] from the [Help] menu.
[F1] key Press the [F1] key on the keyboard.

To verify the content of the open screen, press the [F1] key to display the help that corresponds 
to the open screen.
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1 Enter a keyword to search, and press the [Enter] key on the keyboard.
Topics that match the keyword will be displayed in alphabetical order.

2 Click a topic.

3 Click [Display].
The content of the selected topic will be displayed.

NOTE
• When there are multiple topics for a specific keyword, the [Topics Found] screen is opened. Select 

the specific keyword from the list of titles on the screen, and click [Display].

• The [Search] tab of the help allows full-text searching of help content for terms registered in the 
help.

8.1.2 Using Online Manuals
The contents of the 'Operation Manual' and 'Administration Manual' of the LabSolutions Instruction Manual 
can be viewed on the screen.

1 Click  (Manual) on the [LabSolutions Main] window.
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2 Click the icon of the instruction manual to be viewed.
"Adobe Reader" is started, and the instruction manual is opened.

NOTE
• The "Operation Manual" online manual can be opened by clicking [Online Manual] from the [Help] 

menu.

• Adobe Reader is started for opening the online manual.

• Visit the Adobe web site for more information about Adobe Reader.

8.2 Specifications of LabSolutions GPC

Control Device
• Up to 4 systems can be controlled by one PC, and PDA detectors can be connected to 2 of these systems at 

maximum.
• GPC analysis and ordinary analysis can be performed simultaneously on one PC.
• Data from a GPC or LC device from other manufacturers can be processed by installing an A/D board on the 

system controller (CBM-20A, SCL-10Avp).

No. Description
Click the hierarchically structured bookmarks (table of contents) to display the desired page.
Search for terms used in the manual.
Click the references or the terms in blue to jump to the page of the related item.
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NOTE
Number of controllable systems and the type of controllable devices depend on the LabSolutions license.

Peak Integration
• Peak integration by peak integration parameters, time programs and manipulations can be performed.
• Number of slices: Up to 5000 (by channel. Up to 4 channels can be used in a PDA detector.

Data Analysis

Data Comparison
• Number of data files that can be compared: Up to 10
• Chromatograms, the differential molecular weight distribution curve, and the integral molecular weight 

distribution curve can be overlayed.
• Parallel displacement of chromatograms in the direction of time axis, recalculation of the molecular weight 

distribution by the correction time after parallel displacement, and displaying the molecular weight 
distribution curve are possible.

• Statistical calculation results (average, maximum, minimum, %RSD, standard deviation) of the number 
average molecular weight (Mn), the weight average molecular weight (Mw), the Z average molecular weight 
(Mz), the Z+1 average molecular weight (Mz1), the viscosity average molecular weight (Mv), the intrinsic 
viscosity, and the polydispersity (such as Mw/Mn) for the entire elution curve or any specified range can be 
displayed.

Report
• Reports can be created using flexible formats by selecting the report items (such as chromatogram, 

calibration curve, GPC graph, GPC overlay, and GPC calculation result).
• The output of summary reports and statistical calculation results (average, maximum, minimum, %RSD, 

standard deviation) using the GPC summary items is possible.
• Multiple page layout is supported.
• Reports can be previewed.

File Conversion
• GPC method files of CLASS-LC10/CLASS-VP GPC software can be imported.
• GPC calculation results can be output into an ASCII file.
• LCsolution GPC data files and method files can be read as they are. However, files created with 

LabSolutions GPC cannot be read by LCsolution GPC.

Calibration curve 
approximate equations

Straight line by the least square method, third order equation, third order equation + 
hyperbolic curve, fifth order equation, fifth order equation + hyperbolic curve, seventh order 
equation, seventh order equation + hyperbolic curve, and point-to-point 

Number of data in 
calibration curve

Up to 64

Calibration curve 
correction

Conversion using the Q factor or Mark-Houwink equation.

Time correction Time correction using the internal standard peak or the control sample.
GPC calculation Number average molecular weight (Mn), weight average molecular weight (Mw), Z average 

molecular weight (Mz), Z+1 average molecular weight (Mz1), viscosity average molecular 
weight (Mv), intrinsic viscosity, and polydispersity (such as Mw/Mn) calculations for the 
entire elution curve, for each peak, and for each specified range.

Others Correction of the RID sensitivity.
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